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      BACKUPXPRESS INTRODUCTION
What is BackupXpress?

BackupXpress was originaly written to easily backup and archive the sourcecodes of my software 
projects which are often spread over different directories and contain lots of test files or copies of 
databases which are only needed for testing and are not neccessary in a backup. 

With BackupXpress you can sort out the unwanted files by setting several include and exclude filters.

You can use it for ANY kind of complex copy operations with or without compression.

Who should use BackupXpress 

Scenario #1: Programmers who want to archive their codes

Scenario #2: Users who want to easily backup to ZIP drive

Scenario #3: Update changed files on many different locations with a single mouse click

Scenario #4: Automate the creation of zip archives

What are it's highlights?

· Different backup groups in one backup project of which each has it's own configuration for 
backing up different folders.

· Include files to a backuplist by giving different wildcard filters like '*.pas ; *.dfm' or even '*.*'.
· Exclude files from the backuplist like '*.~*; *.bak' or similar to exclude files not essentialy 

needed in the backup.
· Generate a compressed zipfile of a backup group.
· Visualy mark a backup with the current date or the date of the last modification to easily 

archive differnt backup sets.
· Drag & drop support.
· Backup automation!!, which means performing a backup only by inserting a removable 

medium(like a ZIP-disc) with a backup project on it.
· Command line support for batch automation
· Perform backups at system shutdown (to save your work before you go home)
· Fully featured Zip-Extractor
· Scheduler to start server-backups to specific day or time
· Remote backups by Email or to a Ftp-Server



      BACKUPXPRESS LICENSE INFORMATION
Registration

Single-User: DM 40,- / US $20 / EUR 20,-
+US $5.00 if you intend to pay with cheque.

Please contact me for special price offers:

      5-User: DM 160,- / US $80 / EUR 80,-
 10-User: DM 300,- /    US $150 / EUR 150,-
Unlimited: DM 500,- / US $250 / EUR 250,-

You can also remit the money to the following bank account:
Bank: Advance Bank
BLZ: 702 300 00
Account: 2001770409

Use this Order Form to send the money,check,bank transfer directly to the author by mail.

There is also a way to REGISTER ONLINE by creditcard if you click the 'Register Online' 
menuitem in the BackupXpress mainmenu, or go directly to the Internet-Registration-Site: 
        http://shareit1.element-5.de/programs.html?productid=104199&language=English

Registration Benefits

Here's what you get for your money, if you register: 

· Technical support. Provided through e-mail. I'll answer any question about BackupXpress. I'll do 
my best to solve (or help you to solve) any problems you might have in conjunction with the 
product.

· You are included in the BackupXpress mailing list and are automatically informed if there is a 
new release of BackupXpress.

· No Nag-screen and no copy delay during backup process (which occurs after the 30-day-period)

License Agreement

BackupXpress is Copyright (c) 1997-1999, Andreas Spang.
All rights for this software are reserved by the author.
You are not allowed to modify or reverse engineer the contents of the program files.

BackupXpress is Shareware. That means you can use it free of charge but with several restrictions. If you 
register your copy of BackupXpress by paying a small license fee to the author you will get the full version 
without restrictions.
Besides legalizing your usage of BackupXpress, there're several other reasons to register BackupXpress. Please,



see Registration section for more info.

This software cannot be resold or used in any profit-generating activities, including, but not limited to, 
distributing BackupXpress as part of commercial products, or in support of commercial services, without the 
authors expressed written permission.

There is no warranty or claim of fitness or reliability. The program is distributed AS IS, and the author 
shall not be held liable for any loss of data, down time, loss of revenue or any other direct or indirect 
damage or claims caused by this software.



ORDER FORM - BACKUPXPRESS PRO
Print it out, include the money or cheque and send it to:

Andreas Spang
Breslauerstr.10
86356 Neusaess
Germany

Date: ______________________________________________

Name: ______________________________________________

Company: ______________________________________________

Phone: _____________________      FAX: ___________________

Street: ______________________________________________

Zip/City: _________________    Country: _____________________

Email: ______________________________________________

Single user license    _______        x      US$20 (DM 40,-)          =    ____________

If you pay with cheque add                              US$5      (DM 10,-)          =    ____________
(only for non german cheques)

Total payment                                                                                                                                          =    
____________
(Payment method is either cheque, cash or international money order to
Advance Bank; BLZ: 702 300 00; Account #200 177 0409)

From which website or CD did you get this evaluation version of BackupXpress? 

________________________________________________________

Comment or suggestions?

________________________________________________________



      BACKUPXPRESS TUTORIAL
  

Five steps to your first successfull backup using BackupXpress.

1. Create a new project

2. Add some backup groups

3. Define include, exclude filters

4. Set backup group options

5. Start backup



      BACKUPXPRESS FAQ
set}Frequently asked questions concerning BackupXpress

F: I have different groups in a Project but BackupXpress copies only those groups which 
include files that have been changed. I want to ALWAYS copy ALL groups in the project 
regardless if there are newer files or not.

A: Enter the Dialog 'Project-Options' and select in the Field 'Auto-Select' the Option 'Every 
group'.
_____________________________________________________________________

F: Can BackupXpress backup to tape-streamer, CD-ROM or CD-RW?

A: BackupXpress does not support any external devices, as long as they are not accessible 
via the windows-explorer. Todays CD-R(W)'s support a spezial mode which simulates a 
standard windows-drive, and can be used by BackupXpress.
_____________________________________________________________________

F: I have a large backup project and i often change the group options. Every time i change a 
field in the options the programms does a Rescan of alle files and i have to wait a long time 
till it is finished.

A: You always can cancel the Scanning by pressing ESC (about 2 Sec.). The other way is to 
disable the automatic Scanning by unchecking the 'View->Autorefresh' item in the 
mainmenu. You have to press F5 or click 'View->Refresh' to rescan the group if 'Autorefresh' 
is off.
_____________________________________________________________________

F: I have Windows NT and i am using the Shutdown-Backup option. If i shutdown my 
system by Logging off, it shuts down the system comletely and turns the computer off. How 
can i prevent this?

A: Unfortunaly BackupXpress can not recognize HOW you want to shutdown the system. If 
the backup has finished it shutsdown like you have selected in the configuration dialog.
_____________________________________________________________________

F: I have differnt groups in a project and want to pack them all in the same Zip-Archive. 
How can this be done?

A: Deactivate the option 'Delete zip-archive before copy' for all groups but the first one. This
way they will all be appended to the same Zip-Archive(if you have chosen the same 
destination name for all of the groups)
_____________________________________________________________________



F:    I want BackupXpress to automatically start a backup if I doubleclick on a project file or 
if BackupXpress is running and the scheduler is being used.

A:    Make sure the 'Autostart' option is checked under 'Project Options' in the file menu for 
each group in your project.
_____________________________________________________________________

F: I want BackupXpress to perform a backup automatically, but if there occurs an error, it 
stops with an errormessage. Can i prevent the message to show up?

A: Activate the option 'Don't show errors' in the project options. The error is still logged in 
the logfile.
_____________________________________________________________________

F: I use BackupXpress regular to Backup my files. Sometimes the date it appends to the 
backup name is not equal to the day when the backup was perfomed. What happend?

A: There is an option in the project options called 'Use date of newest file'. If you deselcet it,
it will use todays date.
_____________________________________________________________________

F: If i have a larger backup of 1 GB, BackupXpress seems to hang in the progress dialog 
with the message 'Assembling Zip-Archive' and the program does not respond. What happens
here?

A: At this point the control is passed to an external DLL-File which is used to pack the files 
to a zip-file. This could take several minutes to be finished. Please be patient.



      BACKUPXPRESS SCENARIOS

Scenario #1: Programmers who want to archive their codes

You do a lot of coding and want to have an archive of your source codes where you could step back in
different backups and retrieve code that had better not changed in your current version of your 
project?

BackupXpress can solve this by generating compressed zip files with a date,time or version stamp in 
the filename:

Backups have never been so easy and you don't have to bother your adiministrator to PLEASE get 
one of his backup tapes from his archive if something happened to your source code.

Scenario #2: Users who want to easily backup to ZIP drive

You own a ZIP drive and want to use it as a backup medium. Then BackupXpress is the ultimate 
solution.
Imagine you have three different ZIP disks. One is labeled 'Projects', one 'Homepage' and the last 
one 'Documents'.
· Create a backup project (*.bpr) for each of your zip disks and set the nessecary files and options 

for each backup group
· Copy or save the projects to the related zip disk. E.g. 'BackupProjects.bpr' goes to zip disk 

'Projects' and so on.
· Open the preferences dialog of BackupXpress and enter the 'Misc' tab



· BackupXpress now checks your zip drive every 2 seconds if a zip disk with a backup project is 
inserted and executes it if it finds one.

· If there are different backup projects on one disk you will get a selection dialog wehre you can 
select one ore more projects for execution

· If you set the mark backup option for every group you can archive your data with a date, time or 
version stamp



Scenario #3: Update changed files on many different locations with a single mouse click

We use BackupXpress in my company to update the centralized code library on our server with the 
latest changes. 
· I created two links to backup projects on my desktop. 

· The first gets the latest source files from the server which are different to my local ones
· The second project copies all changed files from my local drive back to the server

Scenario #4: Automate the creation of zip archives

I use BackupXpress to generate the release zip archives of my shareware products.

· In a first backup group i gather some files that are needed in the release but which are not in the 
main backup directory.

· In a second backup group i copy all essential files like '*.exe' or '*.ini' to a compressed zip archive
which is automatically copied to my ftp-upload-directory.

And - e voila - with just one mouse click the latest version of BackupXpress is ready for shipment.



      BACKUPXPRESS HANDBOOK
COMMANDLINE

There are several commandline parameters:

/minimize : Starts BackupXpress minimized
/library : Opens the library after start
/edit : Opens a file in editmode
/auto : Opens a file and automatically starts it

For example:
    backupx.exe /auto mybackup.bpr



      BACKUPXPRESS Handbook
Detailed description of all dialogs, options und menus.

Main window

Menus

Preferences

Scheduler

Filter

Showfiles

Quick access library

Restore Zip-Archive

Commandline



      BACKUPXPRESS Handbook
MAIN WINDOW

Area 1 - Group Listbox
This listbox is the central point of your backup. It contains the different backup groups of your project.
Each backup group can copy and compress files from one location to another. If you want to backup files 
from different directories you have to add a new group for every directory that is not already in a subset 
of an other directory.
A group is rendered in red if the source directory is invalid.
A group is rendered in bold if there are new files in the backup set and a backup should be performed.

The checkmark in front of each group is set automatically after loading or refreshing a project, if 
there are files in the current backupset which are newer then the last backup date.You can also 
check/uncheck them manually.

It is possible to select multiple groups at a time to set a fieldvalue for more then one group to the
same value. (This does not apply to the source path of a group)

You can also add new groups by using drag & drop from the explorer or by using the menuitem "Edit-
>Add Group"



Area 2 - Group Properties
SOURCEPATH: Enter the path where you want to copy the files from. If you use drag & drop this 
field is set automatically. You can also use relative pathnames like '..' or '.'.

DEST.PATH: Enter the path where you want to copy the files to. If the 'copy to zip file' option is set 
then the files are copied to a zip file with the same name as the last directory in the path plus '.zip'.

INCLUDE: Enter filenames with or without wildcards (*,?) to include files into your backupset. 
Seperate them by semicolon.

EXCLUDE: Enter filenames with or without wildcards (*,?) to exclude files from your backupset.
If you enter a filename without extention, then the program excludes a complete directory with this 
name.

FILTER BUTTON: Opens a dialog which lets you edit the include and exclude filters more 
comfortable.

ADD SUBDIRECTORIES: Check this option if you want to include every subdirectory to the 
backup which is in the sourcepath.

COPY TO ZIPFILE: Generate a zip archive with the same name as the Dest.Path.

LAST BACKUP: Date & Time of the last backup of this group. If the background is red it indicates 
that there are files in the group which are newer than this date and a backup should be performed.

SHOW FILES BUTTON: Show a window which displays all files that are in the backup group. 
Right mouse click opens a popup menu with some options.

FILES: Number of files in the backup group.

SIZE: Size of the backup group. 

Area 3 - Project description
Gives a short description of the purpose or content of this backup project. This text is displayed in the 
project library.

Area 4 - Zip File



USE DISK SPANNING: Split zip file if it doesn't fit on a single disk. 

CLEAR ZIP BEFORE COPY: Clear the content of the zip file before add the files. This is usefull if you
want to include more then one directory to the same zip file. Check it for the first group and uncheck it 
for the others.

STRIP PATH FROM ZIP: Lets you specifiy how much of the filepath is included in the zip file.

PASSWORD: Define a password for zip encryption. This it not a very strong protection, but it does a
good job in most cases.

DELETE AFTER: If you want to avoid running out of diskspace when doing daily/weekly/monthly 
backups, you can decide to delete old backup files after xx days. It only deletes files that match the 
destination filename of the current group ignoring the date/version part. 

Area 5 - Archive Panel



MARK BACKUP DIRECTORY: You have the possibility to mark every backup with a date&time or 
version stamp. This lets you easily archive different levels of your backup.

FILE VERSION: You can extract the version information from an executable, which is then used as the 
version number for the filename.

Area 6 - Date Filter Panel

This panel lets you filter files from different dates.

NO FILTER: Take all files, regardless of date

SINCE LAST BACKUP: Take all files younger then the last backup

TODAY: Take all files from today

THIS WEEK: Take all files which have changed this week

THIS MONTH: Take all files which have changed this month

NOT OLDER THEN: Take all files which are not older then xx days.

NEWER FILES ONLY: Includes only files which are newer then the destination files, if there are 
any.

Area 7 - 'Send to' Panel



This panel lets you send a backup to an email account or a ftp server.

EMAIL: Check this if you want to send the resulting zip file to an email account
RECIPIENT: Enter the adress of the recipient
SUBJECT: Enter the subject for the mail. You can use "%d" and "%t" as variables for current date and 
current time. If you leave the subject blank it is automatically set to the filename of the zipfile to send.

FTP: Check this if you want to send the resulting zip file to a ftp server

Area 8 - History Panel
This panel gives you an overview of the last 10 backups which where performed in this group. Press 
right mouse button 'Clear' to clear it.
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FILTER

Area 1 - Preset Filters

The preset filters are pre-defined include and exclude filters. Simply click on it and the filters are set for 
specific purposes.
You can modifiy the preset definition by pressing the right mouse button over one of the buttons. Select 
'Change' from the popup menu and enter the new definition.



Area 2 - Include Filter

Enter filenames with or without wildcards (*,?) to include files into your backupset. 
Seperate them by semicolon.
If you want to include every file enter *.*

Area 3 - Exclude Filter

Enter filenames with or without wildcards (*,?) to exclude files from your backupset.
If you enter a filename without extention, then the program excludes a complete directory with this 
name.



Area 4 - Include Extentions

This listbox displays all extentions which has been found in the specified source directory.
You can include them by checking the checkmark in front of the extention name.

Area 5 - Exclude Extentions

This listbox displays all extentions which has been found in the specified source directory.
You can exclude them by checking the checkmark in front of the extention name.



      BACKUPXPRESS Handbook
PREFERENCES

Project options

SOURCEPATH: This is the standard sourcepath of all backup groups in the project. If the standard 
sourcepath and a group sourcepath are equal and you change the standard sourcepath then the group 
sourcepath is replaced by the new standard sourcepath.
    
DEST.PATH: Same as SOURCEPATH but for DESTINATION PATH

DATEFORMAT: If the 'mark backup with date' option is checked, you can define the display of the date 
and/or time here. You have the following variables:

dd: Day
mm: Month
yy: 2-digit year
yyyy: 4-digit year
ddd: Day of week

hh: Hours
mm: Minutes

COMPRESSION: Specifies the compression level if you want to generate zip files.

AUTOSTART: Start project automatically if double clicked or activated in any other way 
(checkdrives)

AUTOSAVE: Project is saved automatically before exiting BackupXpress



USE DATE OF YOUNGEST FILE: If the 'mark backup with date' option is checked it doesn't uses 
the current date but the date of the youngest file in the backup set to mark the backup destination.

WRITE PROTECT AFTER COPY: Every file is write protected after copying.

COMPLETE BACKUP: Backup every group regardless if a backup would be neccessary or not, 
according to 'Last backup'-date.

LOG ALL COPIED FILES: Write filename of every copied file into the logfile.

DON'T SHOW ERRORS: Don't show error messages during Backup. Errors are still written into 
logfile.

WARN IF DISKSPACE is BELOW 10%: Show warning if free diskspace on destination-drive is 
below 10%.

SET AS DEFAULT: Set project-settings as default for every new project .

Options

OPEN LIBRARY AT STARTUP: Open the quick access library directly after start of BackupXpress.

MINIMIZE AT STARTUP: Start BackupXpress Iconified.

OPEN LAST PROJECT ON STARTUP: Re-open last used project after starting BackupXpress.

LIBRARYPATH: Specifiy the location of your projectfiles. Used by quick-access library.

Automation



CHECK DRIVES: Specifiy which drives should be checked every x seconds.

EVERY X SECONDS: Check every x seconds if a new removeabel medium is inserted into any of the 
specified drives.

DRIVES: Pick the drives which shall be checked every xx seconds. You can also take network drives.

EJECT DISK AFTER COPY: Eject Disk after performing an automated backup. This option only 
works for local drives.

Shutdown

SHUTDOWN BACKUP ACTIVE: Perform backup on system shutdown

AFTER BACKUP: Because it is not possible to continue with the shutdown-selection you chose at the 



Windows-Shutdown-Dialog, you can decide how the system should be shut down after backup.

BACKUP NOT BEFORE: Don't start shutdown backup if time is earlier than this.

SHUTDOWN PROJECTS: List of backup projects which are performed at system shutdown.

Email

Choose if you like to use SMTP or MAPI for sending backups by Email.
If you are using SMTP you can enter your provider and sender name here.

Variables



You can use variables in source and destination path. Those variables are replaced by the related path.
If you add a variable "%HOME% = c:\home" and use a source path of "%HOME%/Project A" then the 
path is replaced to "c:\home\Project A".
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SHOWFILES

The showfiles window gives you an overview of the files and directories that are included in the next 
backup process.

You can open, view or exclude a file or directory from here by right mousebutton popupmenu.



      BACKUPXPRESS TUTORIAL
  

NEW PROJECT
1. If you start BackupXpress for the very first time, you will most likely see an empty window like this.

2. To create a new backup-project please select 'Project->New'

3. The preferences window opens and you can set the projects default source and destination path. 



4. Enter the root path of this backup projects backup groups and the destination path which is most likely a path to 
your backup directory or backup drive. The other options will be explained later.

5. Press 'OK' and your first project will be created.

>> Next step - Add Groups >>
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ADD GROUPS

1. You can now add backup groups to this new project either by using the 'Add Group' menu item or more 
preferable use drag&drop with the windows-explorer.
We will use the 'Add Group' menu utton in this example but using the explorer is much more comfortable.
Click the 'Add Group' menu item now and enter a name for this backup group.

2. After pressing OK you will be asked for the source directory of this group which starts with the project default 
source path we already set in the prefrences dialog. Enter a valid path here an press 'OK'

>> Next step - Define Filters >>
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DEFINE FILTERS
1. Press the 'Filter' button to specifiy which file extentions you want to include or exclude into this backup 
group.

2. You can either choose one of the predefined filters (which by the way are fully configurable by popupmenu) or 
build your own user defined filter.



3. Choose some of the exclude extentions like '*.~pa' and '*.~df' to exclude delphi backup files from the files in 
your backup set and press the 'OK' button.

4. You can now check your selected files by pressing the 'SHOWFILES' button.

5. You can manually edit this list by deleting one or more entrys using the DEL-Key or the 'Popupmenu-
>Exclude'. Excluded files will be added to the exclude field.

>> Next step - Set Options >>





      BACKUPXPRESS TUTORIAL
  

SET OPTIONS

1. You can choose here to add all subdirectories, build a compressed zip file. If you use BackupXpress for archiving
you may want to set one of the 'Mark backup directory' options to append a date or time string to your backup
directory/file. 

2. After this you should enter a short description of this backup project Like 'Archive projects to 
server' or 'Update projects to server'.

3. Select 'Project->save as ...' to save this project to disk and enter a cognitive name like 'Archive 
projects to server.bpr'.



>> Next step - Start Backup >>



      BACKUPXPRESS TUTORIAL
  

START BACKUP
1. Select the group you want to backup by checking the checkbox in front of the name and select 'Action-
>Start backup' to begin the backup process.

 
2. Every selected file is know copied in either a zipfile or your backup directory. If a path doesn't already exists it is 
automaticaly created.

  
3. After finishing the backup process you can track the last ten backups in the history list of every group.



4. Quit BackupXpress and start it again.
If one file in the source directory of a group is newer than the last backup date/time the group is displayed in bold 
and is automtically checked for backup and the field 'LastBackup' is rendered in red.

5. If the 'Autostart' checkbox is checked this allows BackupXpress to automatically start the backup process for 



your project or group(s).    This can be done using a desktop link if BackupXpress is not running, or via the 
scheduler if BackupXpress is running.

You may want to add other groups now to backup a complete project with one single mouse click.
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MENUS

Project menu

NEW PROJECT: Creates a new backup project

OPEN: Open an existing backup project

SAVE: Save project without asking for filename (only when changed)

SAVE AS: Save project with another filename.

PROJECT OPTIONS: Show project options 

LIBRARY: Open quick-access library 

LAST PROJECTS: Last five projects

EXIT: Exit BackupXpress

Edit menu



ADD GROUP: Add a new backup group to project

DELETE GROUP: Delete selected group from project

UN/SELECT ALL: Select or unselect all groups

RENAME: Rename a group

DUPLICATE: Duplicate a group

RESET DATE: Reset the 'Last Backup'-Date

PREFERENCES: Open preferences dialog

View menu

EXPLORE SOURCE DIR.: Opens an explorer window which points to the source directory of the 
current group.

EXPLORE DEST.DIR.: Opens an explorer window which points to the destination directory of the 
current group.

SHOW LOGFILE: Shows the BackupX.log.



CLEAR LOGFILE: Deletes the BackupX.log.

REFRESH(F5): Re-read current group and check if there are any new files to put in the backup set.
You can also press SHIFT-F5 to re-read all groups in project.

AUTOREFRESH: Autorefresh does a re-read of the current group if any of the group properites 
change(filter, path, ...). If you switch it off you have to refresh manually by pressing F5.

Scheduler menu

ACTIVE: Scheduling active yes/no

CONFIGURE: Open the scheduler configuration

Action menu

START BACKUP: Perform backup of the checked groups

RESTORE ZIP-ARCHIVE: Open the restore dialog

CHECK DRIVES: Checks every selected removable drive if any backup projects are on it. If so it opens 
a dialog to select which project to backup.
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QUICK-ACCESS LIBRARY

The quick access library is ment as a replacement for the open-dialog. It show only *.bpr files and 
displays a description for every backup project.

BACKUP: Start one or more selected backup projects.

EDIT: Open the selected project for editing
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CHECKDRIVES

There is a special feature in BackupXpress which can be very usefull for you if you do your backups to ZIP-Disks or
similar.

Choose 'Checkdrives' here and select the drivename of your zipdrive.
BackupXpress checks now every 1 sec. if a new medium is inserted in the selected drives. If there is and you have 
previously copied a BackupXpress project to this disk it is automatically loaded and (after a savety check) 
automatically executed.
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SCHEDULER

SCHEDULER ACTIVE: Switch scheduling on or off here
    
You can see your scheduling plan here. If you double click an item here you can edit it.

Edit Schedule

BACKUPNAME: Enter name of backup which shall be performed.
    
START BACKUP AT: Start the selected backup to this specific time



ACTIVE: If this box is checked, the backup will be performed at it's next scheduling entry.

WEEKLY: Pick several days here on which the backup shall be performed

MONTHLY: If you are doing monthly backups, you can choose here the perform the backup on 
every first day of the month or at the end of every month.

LAST BACKUP: This is when this schedule was last started. Press the reset-button to clear it.

Scheduler window

This is where you see which backup will be performed next.
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RESTORE ARCHIVE

The Restore-Archive-Window enables you to restore your archives without the need of an external 
zip extractor.

ARCHIVES: This is the content of your backupgroups destination directory. You can delete files here by 
right-mouse-button-popup.

ARCHIVE LOCATION: This is the path to the destination directory of the current backupgroup. You 
can change it to what ever you like if you want to view other zip archives.

RESTORE TO: This is where you want the files to be extracted to. It defaults to the source directory of 
the current backupgroup.

FILES: This is the content of the selected zip archive. You can OPEN files by double click or VIEW 
them by right-mouse-button-popup. You can filter the files by their file-extention.






